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Claimed features of 
qualitative and 
quantitative methods 

Qualitative Quantitative 

Soft Hard 

Flexible Fixed 

Subjective Objective 

Political Value-free 

Case study Survey 

Speculative思辯的 Hypothesis testing 

Grounded Abstract抽象的 

Source: Halfpenny, 1979: 799 



質性研究理論淵源 

民族誌（ethnography）、現象學、詮釋學（Hermeneutic）與
符號互動論（symbolic interaction）。 

Lincoln和Guba（2000a）提出實證主義（positivism）、後實
證主義（postpositivism）、批判理論（critical theory）、
建構主義（constructivism）、和參與／合作派典
（participatory/cooperative paradigm）（紐文英）  

Mertens（2004）提出實證主義、後實證主義、建構主義和解放派
典（emancipatory paradigm）四個主要的研究派典，其中解放
派典包含了批判理論、女性主義（紐文英） 。 



質性研究資料蒐集方法拓樸圖 



質性資料（Qualitative Data）

音本資料
（Audio）

文本資料
（Text）

影本資料
（Video）

文本及經驗的代理
（Text as Proxy for Experience）

文本及分析的對象
（Text as Object of Analysis）

系統的引出
（Systematic Elicitation）

自由流動文本
（Free-Flowing Text）

分析（Analysis of:）

會話
（Conversation）

表現（Performance）

文法結構
（Grammatical Structures）

敘事（Narratives）
字

（Words）
譯碼

（Codes）

紮根理論（Grounded Theory）
基模分析（Schema Analysis）
古典內文分析（Classic Content Analysis）
內文字典（Content Dictionaries）
分析介紹/布林邏輯（Analytic Induction/Boolean Algebra）
民族誌決定模式（Ethnographic Decision Models）

KWIC
字數計算（Words Counts）

語譯網絡（Semantic Networks）
認知圖（Cognitive Maps）

自由表單（Free lists）
類別（pile sorts）

成對比較（paired comparisons）
三面檢測（triad tests）

架構替代任務（frame substitution tasks）

成分分析（Componential Analysis）
分類學（Taxonomies）
心理圖（Mental Maps）

分析（Analysis of:） 分析（Analysis of:）



NVIVO 軟體版本差異 

 NVivo 11 Starter for Windows NVivo 11 Pro for Windows NVivo 11 Plus for Windows 

Powerful analysis of text based data. More data types, more complex analysis. Reach findings faster, analyze networks. 

Import and analyze text Get all the features in NVivo Starter AND Get all the features in NVivo Pro AND 

Theme, case and in-vivo coding 

Import and analyze images, video, 
spreadsheets, online surveys, web data and 
information from Facebook, Twitter and 
YouTube 

Social network analysis 

Review coding with coding stripes and highlights Relationship coding Network sociograms 

Text search, word frequency and coding queries Autocode by structure Network metrics 

Charts, word clouds, word trees, explore and 
comparison diagrams 

Merge projects Automated insights 

Import articles from reference management 
software 

Matrix coding and coding comparison queries Pattern based auto coding 

Import from note-taking software Import directly from SurveyMonkey   

Import notes directly from Evernote 
Import, create or order NVivo-ready 
transcripts 

  

Memos and annotations Framework analysis   

Connect to NVivo for Teams 
Tree maps, geovisualizations, cluster analysis, 
project, concept and mind maps 

  

Export and share items 
Import references from reference 
management software 

  

Work with data in virtually any language Access NVivo for Mac at no extra cost   6 

http://www.qsrinternational.com/product/nvivo-mac
http://www.qsrinternational.com/product/nvivo-mac
http://www.qsrinternational.com/product/nvivo-mac
http://www.qsrinternational.com/product/nvivo-mac


質性研究電腦輔助軟體的興起 

壹、質性研究電腦輔助軟體與質性研究之關係 
 

一、質性研究電腦輔助軟體可以增進質性研究之嚴謹性 

二、質性研究電腦輔助軟體可以增進質性研究之信實度 

三、質性研究電腦輔助軟體可以使質性研究更具趣味性 
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四、質性研究電腦輔助軟體可以增進質性研究者之研究能力 

五、質性研究電腦輔助軟體可以節省研究時間 

六、質性研究電腦輔助軟體可以協助質性研究者之團隊合作 
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從GT、CAQDAS到NVivo11 pro 

壹、紮根理論的興起 

• 紮根理論（Grounded Theory）又稱為基礎理
論或簡稱GT理論，是質性研究方法
（qualitative research）之一。 

• Strauss與 Corbin（1990; 1998）指出，紮根理
論系統化的資料登錄分析歷程，包括三個步驟︰ 

 

開放編碼 主軸編碼 選擇性編碼 
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4 
參、NVivo 11 pro的誕生與系統需求 
安裝N 11之前確認電腦符合硬軟體的系統需求建議： 

1. 2.0 GHz 微電腦四核心處理器或更高階（1.2 GHz 
Pentium III-compatible processor (32-bit) 或 1.4 
GHz Pentium 4-compatible processor (64-bit)  

2. 2 GB 隨機存取記憶體或更多 

3. 1280 x 1024螢幕解析度或更佳 

4. 微軟窗口XP SP2或較晚的版本，或微軟視窗Vista SP1或
更較晚的版本，或者微軟視窗7版以上。 

5. 大約2GB的有效硬碟空間（可能需要NVivo項目額外的
硬碟空間） 

6. Internet Explorer7版或更晚的(需要使用NCapture：一
種外掛的自由流覽器允許研究者從網路擷取資料） 

7. 網際網路連線 
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  N11 pro的由來與在台發展 

 NVivo的前身NUD*IST，是一套相當有名
的質性研究資料分析軟體，全名是Non-
numerical Unstructured Data Indexing, 
Searching and Theorizing 。 

 

 中文的意思是非數量化之無結構資料的索
引、搜尋、與理論化，可說是質性研究電
腦化的濫觴。 

11 
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 2006年，QSR 公司結合NUD*IST和NVivo成為全新的資
料庫，又加上其他新的功能，發展成NVivo7，2006年3 
月上市。 

 在國內，由劉世閔的研究團隊所著的《質性研究e點通》
一書，即介紹NVivo7 的基本功能和應用（劉世閔，
2007）。 

 本書介紹的N11 pro 則是在2014年六月上市，和先前版
本最大的不同是提供研究者更多功能來擷取網頁、PDFs、
與社交媒體資料：如臉書（Facebook）、鄰客音
（LinkedIn）或推特（Twitter）資料匯入功能、它也可
透過伺服器連結研究者。 

12 



N11 pro即NVivo軟體第11版，它擷取網頁、
PDFs與社交媒體數據，進行編碼、搜尋和提
取、儲存、備忘錄、資料連結、內容分析，
呈現數據、圖表、模型與視覺化分析等。 

13 



4 
CAQDAS的研發 

• 根據GT理論的發展，於是相關的電腦輔助軟體開

始相應而生，有關質性研究電腦輔助軟體之發展

最早出現在西元1980年代早期，質性研究者開

始用電腦來協助作數據分析（Kelle,1995）。 

• 而Fielding(2000)將質性分析軟體分成三種基本

類型：檔搜尋、編碼及搜尋套裝軟體以及理論的

建立者。 

14 



CAQDAs的功能 

編碼與搜尋軟
體 

規則為基礎的
理論建立系統 

邏輯為基礎的
系統 

索引為基礎的

取向 

概念網絡的系
統 

15 
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• 目前已發展出數套CAQDAs，如：ATLAS.ti、
AnSWR 、NVivo、QDAMiner（編碼、檢索
和分析）、WordStat（文字資料採礦）、
HyperSEARCH（影音與文字）、
HyperTRANSCRIBE、UCINET（社會網路脈
絡分析）及MAXQDA（網路概念圖）等 

國
外 

• 以NVivo 、ATLAS.ti與MAXQDA較聞名 
台
灣 



2 

年度 名稱 備註 

1981年 NUD*IST 1 (全名是Non-numerical Unstructured Data Indexing, 

Searching and Theorizing)是質性研究電腦化的濫觴 

1994年 QSR公司 （Qualitative Solutions and Research Pty Ltd.） 

 

1999年 NVivo 1 

1997年 NUD*IST 4.0 

2000年 NUD*IST5.0 

2002年 NUD*IST 6.0 

2002年 NVivo 2 

2006年3月 NVivo7 

 

(NUD*IST 6.0+NVivo 2) 

2008年3月 NVivo 8 (增強聲音、視訊、圖片與視圖繪製) 

2010年10月 NVivo 9。 

2012年6月 N10 (擷取網頁、PDFs與社交媒體數據結合，如Facebook、
LinkedIn、Twitte，且可以透過伺服器連結不同研究者。) 

2015年9月 N11 Import and analyze images, video, spreadsheets, online 

surveys, web data and information from Facebook, 

Twitter and YouTube 

17 



N11 pro之主要功能 
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3.1在現場做筆記 3.7備忘錄 

3.2編輯 3.8內容分析 

3.3編碼 3.9呈現數據 

3.4儲存 3.10獲得結論及確證 

3.5搜尋和提取 3.11建立理論 

3.6資料連結 3.12視覺化分析 



4.1  
• N11 pro可以增進文件分析之嚴謹性 

4.2  
• N11 pro可以增進文件分析之信實度 

4.3  
• N11 pro可以使文件分析更具趣味性 

19 



2 
N11 pro在文件分析之運用 
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4.4 

•N11 pro增進研究者之文件分析能

力 

4.5  
• N11 pro可以節省文件分析時間 

4.6 
• N11 pro可以協助研究者之團隊合作 



2 

4.7 
•超越時空限制 

4.8 
•文件種類與舉例 

 

21 



內存檔
（Internals）

外聯檔
（Externals）

備忘
（Memos）

原始資料（Sources）

自由節點
（Free Nodes）

樹狀節點
（Tree Nodes）

個案
（Cases）

節點（Nodes）

編碼

屬性
（Attributes）

連結（Links）

建立 建立

備忘錄連結
（Memo Links）

參照連結
（See Also Links）

註解
（Annotations）

組合（Sets）

質詢（Queries）

關
係

（
R

elatio
n

sh
ip

s）
關

係
型

態
（

R
elatio

n
sh

ip
 T

y
p

es）

模
組

（
M

odels）

建立 形成

歸類

進行

進行

編碼

矩陣
（Matrices）

建立

圖片
（Picture）

音訊
（Audio）

文件
（Document）

視訊
（Video）

匯入

NVivo 11質性分析流程圖  



  

本書旨在介紹質性研究資料分析軟體NVivo 
第十版的基本功能，以及其在質性研究上的

應用。 
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影音分析 

Video in Qualitative Research 

Audio in Qualitative Research 
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雲端與網路 

整合型研究 

網路調查(SurveyMonkey)的納入 

書目管理軟體(Endnote, Refworks, Mendeley, 

Zotero) 

From Evernote, onenote 
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file:///E:/N11的圖/7-1 Evernote與NVIVO.docx


Sources 

材料來源 

26 



Source 副檔名 

文檔(Document 

source) 

.docx .doc .rtf .txt 

PDF(PDF source) .pdf 

數據集(Dataset 

source) 

.xlsx .xls .txt 

圖片(Picture source) .bmp .gif .jpg .jpeg .png .tif .tiff 

音頻（Audio source） .mp3 .m4a .wma .wav 

備忘錄(Memo 

source) 

  

視頻（Video source） .mpg .mpeg .mpe .mp4 .avi .wmv 

.mov .qt .3gp .mts .m2ts 2016/4/26 27 



自其他資料來源（From Other 
Sources） 
主要有四種類型資料可以匯入，分別為網頁擷取
（NCapture）、書目管理軟體（EndNote、Mendeley、
RefWorks、Zotero）、筆記本（Evernote、
OneNote）、線上調查網站（SurveyMokey） 

 

2016/4/26 28 



From Endnote X7 

2016/4/26 29 
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2016/4/26 32 



Node 

節點 

Free node 

Tree node 

Relationships 

Node Matrices 
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Collections(分類) 

Collections are views (or groupings) of 

project items that are stored elsewhere in 

your project.  

Sets 

Memo links 

See also links 

Annotations 
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classifications 

分類（classifications）區包含產生新的分類、屬性
（attributes）與關聯式態（relationship types）。
Classifications provide a way to record 

descriptive information about the 

sources, nodes and relationships in your 

project:  

Node classifications 

Relationship types 

 



類屬（Attribute） 

又稱為屬性，是提供研究者建立新的屬性，以將材料分類或
將節點分類中的材料或節點進行屬性的編輯與歸類。屬性是
某實體（某人或某事）所具有的價值（values）、元素
（factors）、特性或抽象概念，係一個物體或個體能被區
別的思維產物，也是欲研究之個案所具有類似或相同的表徵
或標誌，它是一組本身擁有某一特殊性質，即與生俱來之特
性的資料，這組資料經常是由抽象數字或一套模式所呈現。 

凡學生為具有學籍（X）者，當A（學生）具有X（學生學
籍），若A具有學籍，那麼A就具有學生的身分。若B、C 與
D 也具有X屬性，則B、C與D也可稱為學生。 

2016/4/26 37 



 

 分類(Classifications)目錄下有三個功能，分別是原
始資料分類（Source Classifications）、節點資料分
類（Node Classifications）、關係型態
（Relationship Types），如圖3-1。  

2016/4/26 38 
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Set 

群組（Set）是一種快速且彈性的聚集材料來源與節點的
方式，也是一種可以跨項目類型的集合（如圖4-56）。例
如，研究者可以從文檔、備忘錄及屬於某一特殊團隊成員的
節點產生群組。群組中的項是材料來源的參照或「捷徑」，
研究者可以將同類或相互關聯的各類項或跨項的各類資料項
（例如節點、矩陣或材料來源）加以整合於同一群組中，也
可從群組刪除一個項，但該被刪除的項並無法從項目中移除，
因為並沒有實際上移動項到群組，只是刪除掉在群組項的鏈
接而已。 





備忘錄（Memo） 

是一種特殊文件，特指在質性研究的過程中，研究者可藉由
備忘錄將主題、資料收集、資料內容或分析過程紀錄下來，
根據Gibbs (2007)的說明，備忘錄是指使用分析的檔包含
研究者對專案中基本資料與節點的評論。黃世奇、何明軒
（2009）指出，研究者可以新建、匯入或刪除備忘錄，材
料來源中的內部材料、外部材料，以及任何節點的項均可以
建立備忘錄，但是每一個項只能建立一個專屬的備忘錄，無
法重複。 

 

2016/4/26 41 
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Memo links 

Memo Links 

The Memo Links folder shows all the memo 

links in your project.  

If you select a memo link, you can open 

the linked memo, or the project item 

that it is linked to—on the Analyze tab, 

in the Links group, click Memo Link and 

then click Open Linked Memo or Open 

Linked Item. 

You can also delete a memo link by 

deleting it from this folder. 

mk:@MSITStore:C:/PROGRA~1/QSR/NVIVO9~1/DOCUME~1/NVIVO_~1.CHM::/concepts/about_links.htm
mk:@MSITStore:C:/PROGRA~1/QSR/NVIVO9~1/DOCUME~1/NVIVO_~1.CHM::/concepts/about_links.htm


2016/4/26 43 

See Also Links 

The See Also Links folder shows all the 

'see also' links in your project.  

If you select a 'see also' link, you can 

open the 'from' item or the 'to' item—on 

the Analyze tab, in the Links group, click 

See Also link and then click Open From Item 

or Open To Item. 

You can also delete a 'see also' link by 

deleting it from this folder. 

mk:@MSITStore:C:/PROGRA~1/QSR/NVIVO9~1/DOCUME~1/NVIVO_~1.CHM::/concepts/about_links.htm


（1）一整個專案

項目例如一篇文

章或者模型：  

 

 

（2）另一篇資料來

源的局部例如一段選

取的段落或圖片的區

塊。 

 

（3）相同資料來源

的另一部分 

2016/4/26 44 
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Annotations  

The Annotations folder shows all the 

annotations in your project.  

If you select an annotation, you can open 

the source and see the annotation in 

context—on the Home tab, in the Item group, 

click the arrow below Open, and then click 

Open Source. 

You can also delete an annotation by 

deleting it from this folder. 

mk:@MSITStore:C:/PROGRA~1/QSR/NVIVO9~1/DOCUME~1/NVIVO_~1.CHM::/concepts/about_annotations.htm


Query 

46 
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Word Frequency 

Word 

Frequency 
Find the 

most 

frequently 

occurring 

words or 

concepts. 

Look for the most 

frequently 

occurring words in 

a set of interviews.  

 Find the most 

frequently 

occurring themes 

in a document—

where similar 

words are grouped 

into concepts.  

mk:@MSITStore:C:/PROGRA~1/QSR/NVIVO9~1/DOCUME~1/NVIVO_~1.CHM::/procedures/run_a_word_frequency_query.htm
mk:@MSITStore:C:/PROGRA~1/QSR/NVIVO9~1/DOCUME~1/NVIVO_~1.CHM::/procedures/run_a_word_frequency_query.htm
mk:@MSITStore:C:/PROGRA~1/QSR/NVIVO9~1/DOCUME~1/NVIVO_~1.CHM::/procedures/run_a_word_frequency_query.htm
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Matrix 

Matrix 

Coding  

Find a combination 

of items (usually 

nodes and 

attributes) and 

display the 

results in a table. 

Compare what small, medium 

and large businesses say 

about alternative energy.  

 Compare how the terms 

sustainable, conservation 

and global warming  are 

used by different lobby 

groups—run text searches 

and create a node for each 

term and then use the nodes 

in the matrix criteria.  

mk:@MSITStore:C:/PROGRA~1/QSR/NVIVO9~1/DOCUME~1/NVIVO_~1.CHM::/procedures/run_a_matrix_coding_query.htm
mk:@MSITStore:C:/PROGRA~1/QSR/NVIVO9~1/DOCUME~1/NVIVO_~1.CHM::/procedures/run_a_matrix_coding_query.htm
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複合編碼（Compound）  
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compound 

Compound  Use a compound query 

to  

 Combine a text 

search query with a 

coding query  

 Search for two 

words that occur in 

the same paragraph 

(or other specified 

context).  

Find content where the 

term rising sea 

temperature precedes 

content coded at coral.  

 Find content where 

the words habitat and 

sustainable occur in 

the same paragraph.  

mk:@MSITStore:C:/PROGRA~1/QSR/NVIVO9~1/DOCUME~1/NVIVO_~1.CHM::/procedures/run_a_compound_query.htm


2016/4/26 55 
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Coding comparison 

Coding 

comparison 

Compare coding done 

by two users or 

two groups of 

users. 

This query measures 

the 'inter-rater 

reliability' or the 

degree of 

agreement for 

coding done by 

selected users. 

Compare coding 

between users in 

different 

locations or 

from different 

disciplines. 

mk:@MSITStore:C:/PROGRA~1/QSR/NVIVO9~1/DOCUME~1/NVIVO_~1.CHM::/procedures/run_a_coding_comparison_query.htm
mk:@MSITStore:C:/PROGRA~1/QSR/NVIVO9~1/DOCUME~1/NVIVO_~1.CHM::/procedures/run_a_coding_comparison_query.htm
mk:@MSITStore:C:/PROGRA~1/QSR/NVIVO9~1/DOCUME~1/NVIVO_~1.CHM::/procedures/run_a_coding_comparison_query.htm
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群組搜尋功能是尋找項目與項目之間
已建立的某種關聯性，如編碼
（coding）、屬性值（attribute 

value）、關係
（relationships）、參照連結
（see also links）、模式
（models）等等。 
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群組（Group） 





報表 
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Run a predefined report 

To run a predefined report: 

In Navigation View, select Reports, and 

then select the Reports folder. 

In List View, select the report you want to 

run. 

On the Explore tab, in the Reports group, 

click Run Report. 

The Filter Options dialog box opens. 

(Optional) Select any filters you want to 

apply to the data. 

Click OK. The report results are displayed 

in Detail View. 

 

http://help-nv9-en.qsrinternational.com/dialogs/filter_options.htm
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1.細節區：是報表的主要部分，所有的報表均被包含在內。 

2. 欄位清單：包含所有可被添加到該領域的報表。 

3.頁眉和報表標題區。 

（1）頁眉：被印在每一個頁面，例如：頂部可以顯示日期和時間的報表生成的結果。 

（2）報表標題區：該報表頁眉印在報表的前部 -例如：它可以顯示報表標題。研究者
還可以添加一個圖像，例如：一個標誌。 

4.頁腳和報表頁腳區： 

（1）頁面頁腳印在每一頁：例如：底部可以顯示頁碼和總頁數。 

（2）該報表頁腳印在報表底部。這可能包括報表匯總或其他匯總資訊。 



模型 
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文件夾 
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本書的內容 

第一章緒論 

我們針對N11 pro的由來、本書主要內容、 

質性研究電腦輔助軟體的興起、從GT、 

CAQDAS到NVivo11 pro的演變、如何開
始 

使用N11 pro、以及N11 pro新功能簡介進
行介 

紹。 
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2 
第二章文件（File） 

我們依序介紹功能表中的文件（File）提供  

 的項目： 

 新建（New）、保存（Save）、打開 

（Open）、關閉（Close）、信息（Info）、 

管理（Manage）、最近（Recent）、打印 

（Print）、幫助（Help）、選項（Options） 

和退出（Exit）功能。 
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2 
第三章首頁（Home）  

我們針對首頁下的功能鍵包含工作區 

（Workspace）、項（Item）、剪切版 

（Clipboard）、格式（Format）、 

段落（Paragraph）、樣式（Styles）、 

編輯（Editing）與證明（Proofing） 

進行介紹。 
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2 
第四章創建（Create） 

我們針對創建下的功能鍵包含材料來源
（Sources）、節點（Nodes）、項
（Items）、集合（Collections）與分
類（Classifications）五群組進行介紹。 
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2 
第五章外部數據（External Data）  

針對各種格式檔案導入（Import） 

與導出（Export）進行介紹。 
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NVivo 11 Pro可支援匯入之檔案  

圖像  原始資料
的檔案類
型  

檔案類型說明  

文檔(文件
檔)  

包含Microsoft Word (.docx, .doc)  

Adobe PDF (.pdf) Rich text (.rtf)  

Plain text (.txt) 等格式的文件。  

圖片檔  The picture (image) only—to a .jpg 

file The log only—to Microsoft Word 

(.doc, .docx), Adobe PDF (.pdf), plain 

text (.txt) or rich text (.rtf) Both picture 

and log—to a web page (.htm, .html)  
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NVivo 11 pro可支援匯入之檔案  

圖像  原始資料
的檔案類
型  

檔案類型說明  

音頻(聲音
檔) 

聲音檔包含.mp3、.wma與.wav

等格式。 

視頻(影像
檔) 

影像檔包
含.mpg, .mpeg, .mpe, .wmv, .avi, .mov, .q

t 或mp4等格式。 

Dataset  數據組(資
料組) 

Microsoft Excel Worksheet (.xlsx, .xls)  

Tab-delimited text (.txt)  

Web page (.htm, .html)  



視頻 

可點選Video，舉凡MPEG formats (mpg, mpeg, mpe, 

mp4)、Windows Media formats ( avi, wmv)、
QuickTime formats (mov, qt)、3G Mobile Phone 

format (3gp)或AVCHD High Definition Video 

formats (mts, m2ts) 等格式都可導入。 
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2 
第六章分析（Analyze） 

針對材料的： 

1. 編碼（Coding）：使用手工或自動編碼技巧編碼原
始資料 

2. 取消編碼（Uncoding）：解碼編碼內容 

3. 鏈接（Links）：使用備忘錄鏈接（memo links）、
另見鏈接（'see also' links） 

4. 和超鏈接（hyperlinks）來鏈接原始資料內容 

5. 批注（Annotations）：批注原始資料 

6. 框架矩陣（Framework Matrix）：增加與刪除總結 

7. 鏈接（summary links）或自動地從結點產生總結 

以上五個部分依次介紹。 
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2 
第七章查詢（Query） 

針對查詢功能鍵下的查找（Find）、 

創建（Create）與操作（Actions） 

三群組功能進行介紹。 
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2 
第八章探索（Explore） 

針對探索功能鍵下的報表（Reports）、 

模型（Models）、可視化（Visualizations） 

及分類表（Classification Sheets）四大群 

組功能做介紹。 
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2 
第九章布局（Layout） 

針對布局功能鍵下包含 

   行與列（Rows & Columns）、 

   工具（Tools）、 

   排序與篩選（Sort & Filter）、 

   顯示/隱藏（Show/Hide）、 

   頁（Page）作介紹。 
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2 
第十章視圖（View） 

我們針對視圖底功能鍵下包含工作區
（Workspace）、窗口（Window）、列
表視圖（List View）、編碼（Coding）、
鏈接（Links）、明細視圖（Detail 
View）、參考點（Reference）、可視化
（Visualization）作介紹 
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2 
第十一章媒體（Media） 

針對媒體功能鍵下的顯示 

（Display）、回放（Playback）、 

選擇（Selection）、導入（Import） 

四大群組功能作介紹。 
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2 
第十二章圖片（Picture） 

針對圖片功能鍵下的顯示 

（Display）、調整（Adjust）、 

選擇（Selection）、導入（Import） 

作介紹。 
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2 
第十三章模型（Model） 

針對模型功能鍵下的顯示 

（Display）、形狀（Shapes）、 

連接線（Connectors）、項（Items）、 

組（Groups）等分區功能進行介紹。 
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2 
第十四章圖表（Chart） 

針對圖表功能鍵下的當前選擇 

（Current Selection）、標題（Title）、 

標籤（Labels）、類型（Type）、選項 

（Options）、網格線（Gridlines）及 

旋轉（Rotation）作介紹，並呈現12種 

圖表範例。 
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2 
第十五章應用實例 

我們以N11 pro作為研究工具，實
際進行質性研究之分析案例，研究
者可以參閱本章研究範例，更深入
了解數位化質性研究N11 pro在質
性研究上的強大功能。 
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開始使用NVivo11 pro 

壹、開啟N11 pro 
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5 
貳、新增項目 
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5 
參、NVivo 11 pro介面介紹 
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NVivo11 pro新功能簡介 

壹、N11 pro的新建網路與社交媒體對話網站資料的連結與
匯入功能： 

一、NCapture 
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NCapture擷取社交網站資料為Dateset 
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Facebook 

Twitter 

LinkedIn 



  

二、將社交媒體對話網站匯入NVivo 11 pro 

• NVivo 11 pro新建一項功能NCapture，這項功能可以利

用社會媒體(Social media conversations)例如，臉書

（Facebook），推特（Twitter）, 鄰客音（LinkenIn）

等社交網站服務系統相結合。 

• 研究者可以從自己的帳號進入後，在上述網站的工具下拉

選單有NCapture for NVivo，點選該選項後，然後按

Capture鍵。 

94 



   

 以Facebook為例，可以利用社團方式將主要報
導人放入同一社團，假如研究者在臉書發表一則
開放式問題，N 11具備處理與分析從網路下載之
資料與檔案，將會增加研究的方便性。 

 

 網路社交網站所進行的焦點團體訪談成為可能，
N11 pro可結合Facebook、twitter、linkenIn
等社交網站進行網路焦點團體訪談，擷取後成為
資料組(Dataset)型態。 
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1 
以Ncapture擷取Facebook的社團資料 

Row ID 名称 列 B 材料来源 参考点 创建日期 创建人 修改日期 修改人 

1 魯凱族 0 0 

2014/5/30 下
午 09:04:34 CHIAHNAI 

2014/5/30 下
午 09:04:34 CHIAHNAI 

2 傳統文化 0 0 

2014/5/30 下
午 09:10:41 CHIAHNAI 

2014/5/30 下
午 09:10:41 CHIAHNAI 

3 圖騰 1 4 

2014/5/30 下
午 09:15:45 CHIAHNAI 

2014/5/31 下
午 03:38:22 CHIAHNAI 

4 祭典儀式 1 45 

2014/5/30 下
午 09:15:28 CHIAHNAI 

2014/5/31 下
午 03:24:37 CHIAHNAI 

5 村落家屋 2 4 

2014/5/30 下
午 09:13:43 CHIAHNAI 

2014/5/31 下
午 03:26:56 CHIAHNAI 

6 下山社 0 0 

2014/5/30 下
午 09:02:35 CHIAHNAI 

2014/5/30 下
午 09:02:35 CHIAHNAI 

7 歷史 2 12 

2014/5/30 下
午 09:06:18 CHIAHNAI 

2014/5/31 下
午 03:17:35 CHIAHNAI 

8 萬山岩雕 2 19 

2014/5/30 下
午 09:06:53 CHIAHNAI 

2014/5/31 下
午 03:20:20 CHIAHNAI 

9 永續發展 2 72 

2014/5/30 下
午 09:08:19 CHIAHNAI 

2014/5/31 下
午 03:22:20 CHIAHNAI 
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Dataset 

利用其Filter來篩選形成Dataset的資料 
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三、原NVivo 11 pro的功能簡介 
 

（1）內存檔 

 

Icon Source 副檔名 

Document source .docx .doc .rtf .txt 

PDF source .pdf 

Dataset source .xlsx .xls .txt 

Picture source .bmp .gif .jpg .jpeg .png .tif .tiff 

Audio source .mp3 .m4a .wma .wav 

Memo source   

  Video source 
.mpg .mpeg .mpe .mp4 .avi .wmv 

.mov .qt .3gp .mts .m2ts 



  

（2）外聯檔（externals） 

（3）備忘錄 

（4）框架矩陣 
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5 
N11 pro配備各式布林邏輯 

* 

? 

And 

Not 

or Required 

near 

fuzzy與 

Prohibit 

100 



N11 pro可讀取與轉換不同電腦輔助軟體之間
的資料，例如NVivo 10以下的系列產品，
Atlas.ti XML export( *.xml), MaxQDA 

Porjects (*.mx3, *.mx4, *.mx5) 與
FrameWork Export(*.fez)與NVivo 雲端產生
的資料(NVivo Sever Projects)。 
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提供七種國際語言 

美 簡體中文 法 德 日 葡萄牙 西班牙 



N11 pro提供各式圖表，例如矩陣
（Matrices），視圖（Charts，有14種可供
選擇）與模型(Models，可繪製樹狀節點圖) ，
可以將上述的文件歸納成節點後呈現彼此關
係，可輕易地處理橫跨歷史與地理的各式文
件彼此的關聯性與結構性。 
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N11 pro可讀取與轉換不同電腦輔助軟體之間
的資料，例如NVivo 9以下的系列產品，
Atlas.ti XML export( *.xml), MaxQDA 

Porjects (*.mx3, *.mx4, *.mx5) 與
FrameWork Export(*.fez)與NVivo 雲端產生
的資料(NVivo Sever Projects)。 
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N11 pro提供各式圖表，例如矩陣
（Matrices），視圖（Charts，有14種可供
選擇）與模型(Models，可繪製樹狀節點圖) ，
可以將上述的文件歸納成節點後呈現彼此關
係，可輕易地處理橫跨歷史與地理的各式文
件彼此的關聯性與結構性。 
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利用server進行遠距整合型研究 
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專案合併圖 
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應用實例 



  

臺灣國民小學「國語」教科書之政治人物描
述與政治意識型態之探究—以NVivo 10分析
自西元1952到1993年七次國編版本為例 ~ 
 

 

 

 

本文感謝國立編譯館蘇琇敏、陳建民、黃欣柔、何思瞇等研
究員協助蒐集相關教科書資料，一併致謝。 
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1 
第一節 緒論 

 

壹、脈絡背景與動機 
 

貳、為何要研究此階段的國語教科書？ 
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2 
第二節 文獻探討 

壹、文獻的蒐集與整理 

• 西文電子資料庫：Acer Walking Library、Ebook 
Collection、EBSCOhost全文資料庫（含ERIC）、
Oxford Scholarship Online、PQDT、 Sage 
eReference、 SDOL、Wiley online Library與WOS。 

 

• 中文電子資料庫：ACI學術引文文獻資料庫、Digital 
Dissertation Consortium（數位化論文典藏聯盟）、華
藝線上圖書館  (CEPS 中文電子期刊+CETD 中文電子論
文）、中華民國期刊論文索引WWW版、教育論文線上資
料庫EDD Online、數位典藏國家型科技計畫、台灣博碩
士論文加值系統與中國期刊全文數據庫。 
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資料庫名稱 
輸出到Endnote 

X7的相關字 
輸出公式 備註 

華藝線上圖書館  (CEPS 中
文電子期刊+CETD 中文電
子論文 

書目匯出 勾選所要的書目>書目匯出>在「匯出格
式」選擇「輸出至Endnote」>匯出>開
啟 

由於華藝的文獻下載有驗證
碼設定，因此要將檔案儲存
後複製到Endnote X7的相
關書目，在此書目的詳目狀
態將檔案複製到其file 
Attachment下。 

中國期刊全文數據庫 導出 勾選書目>導出>輸出到本地檔>儲存>
另存新檔>儲存成*.txt的格式>打開
Endnote X7>File>Import 
File>Endnote import>import 

輸出到本地檔務必先選擇
Endnote格式 

EBSCOhost全文資料庫 直接匯出為
RIS格式 

先勾選所欲的書目 變成 後，點選位於
EBSCO上方右側的資料夾>選取>匯出>
儲存>直接匯出為RIS格式>開啟 

先將所欲選取的書目，點選  
成為 ，待確認後，點選資
料夾。 

Sage eReference Export 
citation 

輸入所欲查找的關鍵字後會出現簡目，
點選簡目的標題，右側即會出現Export 
citation。 

研究者亦可點選所欲查找的
簡目，進入詳目狀態，右側
即會出現Export citation。 

SDOL Export Export>Export File RIS Export (for 
Endnote)>開啟 

若使用Refwork時，也可利
用RIS匯出。SDOL可以利
用Endnote X7的全文查找
（Find Full Text）將對應的
書目與檔案結合。  

Wiley online Library Export 
Citation 

勾選所與會出的書目> Export 
Citation>將Formate改成
Endnote>Submit>開啟  

Wiley在匯出時加設了
Format，研究者記得在右
側的箭頭選項選擇Endnote
即可。 

WOS (Web of Science-SCIE& 
SSCI) 

儲存至Endnote 
desktop 

儲存至Endnote desktop>傳送 WOS的書目未必有全文，因此
匯入前要留意選取。 
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2 
將Endnote X7匯出成XML 
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2 
自Endnote 
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2 
位於Source Classifications的References 
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2 
導出分類表 
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2 
還原至Endnote 
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2 
貳、臺灣國編版國語教科書的歷史發展與脈絡 

一、中國化教育統治期 

二、精神國防與復興文化期 

三、退出聯合國期 

四、本土意識萌芽、強人病歿到解嚴期 

五、兩岸交流、臺灣主體期與國際化時期 

六、課程多元與審定期 

 

119 



2 
參、教科書與政治意識型態 
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3 
第三節 研究方法與設計 

壹、內容分析 

貳、運用質性資料分析電腦輔助軟體  

        NVivo 10協助編碼 

參、可靠度與真實性 
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3 以NVivo 11 pro繪製國編版國語課本主要出現的政治人物樹狀模
型圖 
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3 
呈現表格狀的行列矩陣 
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3 
為矩陣編碼單元格標示顏色 
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3 
中國政治人物與七次課程標準的節點矩陣圖 
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3 
國立編譯館研究小組與研究者的編碼比較節錄一覽表 

Node Kappa Agreement (%) Disagreement (%) 

政治領袖\歷代君王\周文王 0 82.68 17.32 

政治領袖\歷代君王\周武王 0 88.9 11.1 

政治領袖\歷代君王\唐堯 1 100 0 

政治領袖\歷代君王\夏少康 0.7507 90.35 9.65 

政治領袖\歷代君王\夏禹 0 91.38 8.62 

政治領袖\歷代君王\商湯 0.448 91.24 8.76 

政治領袖\歷代君王\虞舜 1 100 0 

政治領袖\歷代君王\漢劉秀 1 100 0 
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4 
第四節 結果與討論 

 

壹、政治人物的人格特質數量分析與描述 

貳、中國認同與國族主義 

參、反攻復國與討伐暴虐 
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4 

不同政治人物在七次課程標準分配課數
一覽表（以NVivo 11 pro的Charts處理） 
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2 
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4 
二、統編版「國語」教科書對政治人物的特質描述 

（一）好學 
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國父小的時候 



4 
聽太平軍老兵講洪秀全故事的孫中山 
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4 
蔣介石先生看逆水上游的小魚 
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4 

「泥土與微生蟲」 
一課蔣中正先生與日本教官的爭辯 
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台版教科書對西安事變的描述 

誰知張學良、楊虎城，受了共匪的嗾使，乘著 蔣總統到西
安視察的時候，偷偷的派了許多兵，把行轅包圍起來，並且
提出許多無理的條件，強請 蔣總統簽字。 

張、楊二人，因深受 蔣總統偉大人格的感召，和全國軍民
的指責，便在十二月二十五日，由張學良護送 蔣總統回南
京。當時全國軍民瘋狂慶祝，比任何節日都熱烈。」 

  同學們聽完之後，都覺得 蔣總統太偉大了。
41010721 
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西安事變的槍戰彈孔 

136 



少帥張學良(西安事變時的模樣) 
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張學良大陸西安華清池上的海報 
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4 
楊虎城將軍在兩岸評價兩極 
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4 
參、反攻復國與討伐暴虐 

少康中興 
 

141 



4 
   

昆陽之戰 
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鄭成功的三國觀點(日本) 

143 



台灣的延平郡王 

144 



鄭成功是明末的遺臣。自從清兵入關，占據了整個的大陸，
鄭成功深感國破家亡的悲哀，便立志驅滿復明。 

我們每個人必須有鄭成功的精神，才能把中國復興起來。 

41010818  

但是鄭成功仍不灰心，他想找一個形勢比較好的地方，做為
恢復祖國的根據地，於是選定了臺灣。臺灣本來是中國的領
土，不過在明朝末年被荷蘭人強佔了。鄭成功就帶兵和荷蘭
人苦戰了九個多月，終於把荷蘭人趕走。 

他[鄭成功]本想把臺灣建設好了以後，再向大陸進兵，驅滿
復明，不料一病去世，年才三十九歲。 

51010721  
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出師 鄭成功 

縞素臨江誓滅胡， 

雄師十萬氣吞吳； 

試看天塹投鞭渡， 

不信中原不姓朱。 

 注：此詩是鄭成功在永曆三年舉兵北伐，大軍迫近南京時
所作。原題為：「出師討滿夷自瓜州至金陵。」 
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臺灣是中華民國的領土，臺灣的同胞，都是黃帝的子孫。 

[鄭成功]和清朝對抗。他是明末的遺臣，一心要恢復明室，
打算把臺灣建設起來，作為根據地。51011105 

 

鄭成功是福建省南安縣人。明朝末年，清兵攻占南京，鄭成
功就跟他父親鄭芝龍到了福州，在明唐王部下做官。
57010722 

 

57010722 

後來鄭成功因病去世，但是他對臺灣同胞的愛護熱誠，和忠
貞愛國的精神，永遠為後世所敬仰。57010722 
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鄭成功先攻占廈門做根據地，後來又率領大軍進攻南京。鄭
成功在廈門操練海軍，然後帶領大軍進攻南京，但是沒有攻
下，只好退回廈門。他為了再找一個更好的基地，就決定帶
領大軍來到台灣來。64030711 
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廈門鼓浪嶼上的鄭成功 (廈門有鄭成功時期的演兵路) 
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項莊舞劍  志在沛公  老江舞劍 志在台灣 

香港《大公报》2005年3月8日，江澤民同志在離任前，特
別委託專家製作了80件福建德化“中國白”瓷雕。 

“中國民瓷都”福建省德化縣的著名陶瓷藝術大師、辛默樓主
陳仁海，去年8月接到一項來自中央軍委的訂單，內容是江
澤民要訂制50件德化名瓷“中國白”瓷雕藝術品，主題是“鄭
成功收復臺灣”。 

並直接送給當時正在廈門視察軍隊工作的江澤民同志審閱。
據稱，設計稿經江澤民前後審閱三次才定稿。根據設計，該
作品是頭戴盔甲、身披戰袍、手按寶劍的鄭成功，站在一艘
劈波斬浪的戰船船頭揮師前進，身後高懸的桅帆、旌旗映襯
著高大威猛的鄭成功。 
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李自成的兩岸角色 (北京城西郊李自成
騎馬圖) “新順王” 
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台灣 

南一版 

流寇李自成攻陷北京，思宗自縊亡國。 

康軒版 

明末，陜西發生大饑荒，邊防軍也因欠糧而叛變。災民與飢
兵結合，到處劫掠，形成多股流寇。其中以李自成、張獻忠
勢力最強。崇禎十七年，李自成攻陷北京，明思宗自縊殉國，
最後明亡。 

李自成在台灣版被視為流寇，但在大陸版卻被視為農民起義
的英雄。農民革命的典範。 

152 



共產黨黨旗榔頭(工)鐮刀(農)革命 
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4 
統編版國語教科書顯示中國政治人物關係模型圖 
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5 
第五節 結論、省思與建議 

 

壹、結論 
 

貳、省思與建議 
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5 
壹、結論 

一、強化領袖認同與鞏固領導 

二、恪守大中國思維信仰 

三、宣揚反共復國的意識投射 

四、強化邪不勝正的邏輯 
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5 
貳、省思與建議 

一、省思 

二、建議 

（一）對語文教科書的編輯之建議 

（二）對教育工作者使用語文教科書之建議 

（三）對學校選用語文教科書之建議 

（四）對未來研究之建議 
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N11 pro可以幫我做什麼? 

整理學生作業 

視圖化學生表現 

製作多媒體教材(音/視頻,圖與文字) 

利用社交網路徵詢意見 (Facebook、LinkedIn或Twitter） 

整理教學所需文獻(EndnoteX7, Refwork) 

建構關係網絡 

建立個人小型資料庫 

管理檔案 
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Nvivo 台灣代理商 

黃先生 Richard Huang  

柏際公司 BockyTech, Inc. 

Phone:0966652355 

Tel:886-2-2361-8050 Ext.804 

Fax:886-2-2361-9803 

E-mail:richard@bockytech.com.tw 

URL: Http://www.bockytech.com.tw 

 



三星課程網 
www.tutortristar.com 
 

2016/4/26 161 

http://www.tutortristar.com/


台灣何處可購買NVivo 11, Atlas.ti 
7, Endnote X7 

 

全傑科技 
 

TEL:02-25078298 

FAX:25078303 

E-mail: 

info@softhome.com.tw 

Web: www.softhome.com.tw 

隼皓資訊有限公司 

洪仲林 

info@gavinfo

.com 

www.gavinfo.

com 

0937338256  
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結語CAQDAS 

These packages, of course, won’t study for 

you.  But they just might make your hard 

work more efficient.  

It is significant to ensure that CAQDAS 

fits suitably with the data you produce.  

 

 



庖丁解牛的故事說明理念在技術之上。 

看山是山，看山不是山，看山是山，此三歷程的心境卻相當
不同。 

 

角度與視域 



No pains, no gains. 

Traditionally thesis-writing 
logic 



Smart-working > Hard-working 

However…in this e-learning 
era  
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馬莉蓮夢露與愛因思坦? 
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研究是什麼? 

研究=不斷閱讀+ 創意 
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創意vs.質性研究 



劉世閔老師2014年的新書 
數位化質性研究:NVivo 10之圖解與應用 

購書專線：高等教育：林慧華小姐 0924129030 

172 
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報告完畢 

謝謝您的指教，有任何的問題，請來信： 

 sml206@nknucc.nknu.edu.tw 

劉世閔老師的聯絡方式 

886-7-7172930ext.2184 

FB:NVivo 10專業社團 

mailto:sml206@nknucc.nknu.edu.tw

